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Objectives
.

e Describe how Windows stores files.
e |dentify parts of the File Explorer window.

e Use File Explorer to navigate folders on your
computer.

e Copy, move, delete, and rename files.
e Create and use shortcuts.

e Search for files.

e Identify file types.
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Words to Know
« /]

Lesson 3

e application file
Clipboard
contextual tab
data file

disk

drive
executable file
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o fi
o fi
o fi
o fi

e attribute

e path

e system

e type (file format)

e folder
e library
e pIn

CLB: A Comp Guide to IC3 5E



Words to Know (continued)
-

Recycle Bin
removable media
root directory
shortcut
subfolder

system file

tag

USB drive
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Understanding How Windows
Stores Files

e A file is a collection of data stored together.

e Files are stored in folders, which are
containers for related files, and on drives,
which are storage devices.

e Drives contain certain types of disks, which
are storage media, including removable
media and hard disks.

Lesson 3

Morrison / Wells / Ruffolo CLB: A Comp Guide to IC3 5E



Understanding How Windows
Stores Files (continued)

e Removable media are disks that you insert or
attach to a computer, such as USB drives (also
called flash drives and thumb drives) and digital
video discs (DVDs).

e The term hard disk refers to a disk installed In
the system unit that can store many gigabytes of
data economically.

An external hard disk Is contained in a
removable drive that you can attach to your
computer.
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Understanding How Windows
Stores Files (continued)

e Windows names the
drives on the computer
by assigning each drive
a letter.

o The hard drlve . Hard drive C
containing the operating

™ system is named drive
§ C by default. -
@ e The remaining drives &~
— can have any other
letter from D to Z, FIGURE 3-1

followed by a colon (;).
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Understanding How Windows
Stores Files (continued)

e \Windows organizes the folders and files in a
structure, or hierarchy, called a file system.

e At the top of the file system is the root
directory, which is where Windows stores
system files and folders.

e These folders contain other folders, called
subfolders, in which you can store your own
files.
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Understanding How Windows
Stores Files (continued)

n 1 Root directory (C:)
X i -

System folder System folder System folder

Subfolder Subfolder Subfolder Subfolder Subfolder Subfolder
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Using File Explorer
-

Lesson 3
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File Explorer is the Windows 8 file management tool
you use to organize your files.

File Explorer displays the contents of your computer,
using icons to represent drives, folders, and files.

Windows provides four folders for your personal
files: Documents, Music, Pictures, and Videos.

The Desktop folder provides access to system
resources such as the Recycle Bin.

The Download folder is for files you download, or
copy from the Internet.
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Using File Explorer (continued)
S

Quick Access Toolbar

E Address bar Minimize button
- = / This PC n

d

'l—ltle bar Computer View
-, 3 » v ¢ "
. r This PC ‘ Close button
Ribbon . :
(COHapsed) 4 3¢ Favorites 4 Folders (6)
Deskt .
~ 7 Maximize/Restore
# Downloads E Desktop (3 Documents D b
S own button
NaV)gathﬂ ', Recent places
\ <

pane o) oo ’V‘ Downloads ldr} Music
C '™ This PC i Pictures . Videos nght pane
o S Network 4 Devices and drives (3)
U) Local Disk (C:) &

- N DVD RW Drive (D:
m - — \9 rive (D:)
m Removable Disk (E:)
| -
6 GB free of 3.72 G Status bar
Sitems - ;‘
FIGURE 3-3
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Using File Explorer (continued)
S

e Folder Navigation

e To work with files and folders, you can use the
Navigation pane.

e \When you select a folder in the Navigation pane, the
contents of that folder appear in the right pane.

e To view the subfolders contained in a folder, you
click on the expand icon.

You click on the collapse icon to hide the folder’s
subfolders.

e You can also double-click any device, drive, or folder
In the right pane to display its contents.
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Using File Explorer (continued)

Lesson 3

e Folder Navigation (continued)

e A library displays similar types of files
together, no matter where they are stored, so
you can access them easily.

e In contrast, a folder stores files in a specific
location.

e A contextual tab contains options related to
your current task or location.
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Using File Explorer (continued)
S

e Navigating to Your Data Files

e The file path indicates where a file is stored on your
computer by leading you through the folder and file
organization to your file.

Removable Disk (E:) » Module 1 » Lesson 3 P Basics.docx
- Removable Disk (E:)—The drive name
- Module 1—A top-level folder on drive E
— Lesson 3—A subfolder in the Module 1 folder
— Basics.docx—The full filename of the file
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Using File Explorer (continued)
S

e Changing View Settings

e Using File Explorer, you can view the contents of
a folder in eight ways: Extra large icons, Large
icons, Medium icons, Small icons, List, Detalls,

Tiles, and Content.

e To change the File Explorer view setting to any
one of the eight views, you use the View tab on
the Ribbon.

e To switch to Detalls view or Large icons view,
you can use the view buttons on the status bar.
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Using File Explorer (continued)
S
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e Changing View Settings (continued)

|
B setect an
Select none

oo Invert selection

= O

Lesson 3
i) New item ~
£ Easy access ~ ¢
Delete New Properties
B folder v £ History
Removable Disk (E) » Module1 » Lesson3
m -
- +
{
Basics Earth Flower Harmony
& Takea (=@
I
Organize Sample Welcome

Notes

FIGURE 3-7
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the Notes Kle

Thumbnail of
the Harmony Kle

Large icons
view button

47 New item ~
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Delete New
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File details

Details view
button
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Managing Files
-

e To organize files, you group similar files
together in a folder, preferably a subfolder in
one of the Windows default folders, such as
Pictures or Documents.

e Separate files into subfolders depending on
the purpose or subject matter of the files, and
then organize the subfolders from the top
down.
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Managing Files (continued)
-

Documents
folder
|
| | |
Courses folder Personal folder Screenplay
folder
|
™ |
c
o
7))
n Accounting Communications Computer Media Studies
()] folder folder Literacy folder  folder
- © 2015 Cengage Learning
FIGURE 3-9
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Managing Files (continued)
-

e Creating Folders

e Before you create files, you use File Explorer to
create folders to contain the files.

e You can use three methods in File Explorer to
create folders: the Home tab on the Ribbon, a
shortcut menu, and the Quick Access Toolbar.

e A shortcut menu is a menu that appears when
you right-click an object on the screen.

e Shortcut menus list commands you can use with
the object you right-clicked.
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Managing Files (continued)

Lesson 3

e Creating Folders (continued)

New folder button on
the Quick Access Toolbar

New folder button
on the Home tab

e Removable Disk (E:)
Module 1

Lesson 3

New folder

288 P~ Lesson 3
Home Share View 0
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Basics Earth Flower Harmony
Z Takea (2
" ; tour ]
Notes Organize Sample Welcome
FIGURE 3-10
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Managing Files (continued)
-

e Copying and Moving Files and Folders

e To organize files into folders, you can copy or move
the files.

e Copying places a duplicate of a file in a new
location.

e Moving removes a file from its current location and
places it in the destination folder.

File Explorer provides several methods for copying
and moving files and folders.

e Some methods use the Clipboard, which is a
temporary storage area for files and information.

Lesson 3
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Managing Files (continued)
-

Lesson 3

e Copying and Moving Files and Folders

(continued)

Shortcut menu
Keyboard

shortcut

Home tab

Drag

Right-drag

TABLE 3-2

Right-click a file or folder, click Copy on
the shortcut menu, right-click the desti-
nation folder, and then click Paste.

Click a file or folder, press the Ctrl+C
keys, click the destination folder, and
then press the Ctrl+V keys.

On the Home tab, in the Organize group,
click the Copy to button, and then click a
location or click Choose location to open
the Copy Items dialog box and navigate to
the destination folder.

If the destination folder is on a different
drive, drag a file or folder to the destina-
tion folder.

Using a mouse, point to a file or folder,
press and hold the right mouse button, and
then drag the file or folder to a new loca-
tion. Release the mouse button, and then
click Copy here on the shortcut menu. (You
cannot use this method on a touchscreen.)

Right-click a file or folder, click Cut on
the shortcut menu, right-click the desti-
nation folder, and then click Paste.

Click a file or folder, press the Ctrl+X
keys, click the destination folder, and
then press the Ctrl+V keys.

On the Home tab, in the Organize group,
click the Move to button, and then click a
location or click Choose location to open
the Move Items dialog box and navigate to
the destination folder.

If the destination folder is on the same
drive, drag a file or folder to the destina-
tion folder,

Using a mouse, point to a file or folder,
press and hold the right mouse button, and
then drag the file or folder to a new loca-
tion. Release the mouse button, and then
click Move here on the shortcut menu. (You
cannot use this method on a touchscreen.)

@ 2015 Cengage Leaming
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Managing Files (continued)
-

e Deleting Files and Folders

e You should periodically delete files and folders you no longer
need.

e You delete a file or folder in File Explorer by deleting an icon.

e When you delete a file from a hard disk, Windows removes the
file from the folder but stores the file contents in the Recycle
Bin.

e The Recycle Bin is an area on your hard disk that holds
deleted files until you remove them permanently.

e You can retrieve a file from the Recycle Bin; but after you
empty the Recycle Bin, you can no longer recover the files it
contained.
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Managing Files (continued)

Lesson 3
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Renaming Files
Filenames should reflect the contents of the file.

The main part of a filename can have up to 255
characters.

You can use spaces and certain punctuation
symbols in your filenames, but not the symbols
[\ :*7? <>or| because these characters have
special meanings in Windows.
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Managing Files (continued)
-

e Renaming Files (continued)

e Keep the following guidelines in mind as you
name files:

— Use descriptive names—Use filenames that are long
enough to be meaningful, but short enough to be read
easily on the screen.

- Do not change the file extension—If you change the
file extension, Windows might not be able to find a
program to open it.

- Follow a pattern—Use a consistent naming scheme
that is clear to you.
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Managing Files (continued)
-

e Creating Shortcuts

e In Windows, a shortcut is an icon or a tile that
provides a quick way to perform an action such as
opening a folder or a file.

e You can create a shortcut in two places: on the Start
screen and on the desktop.

You can add, or pin, a folder to the Start screen,
where it appears as a tile.

You can create shortcuts on the desktop to access
drives, folders, files, Web pages, applications, or
other computer resources.

Lesson 3
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Managing Files (continued)
-

e Creating Shortcuts (continued)

Backgrounds
folder tile

Lesson 3
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Managing Files (continued)
-

e Searching for Files

e |f you are not sure where a file Is stored, you can
use the Search box in File Explorer to find a file.

e Start typing text associated with the file into the
Search box. Windows searches for the file by
examining the names of the files displayed in the
current folder and files in its subfolders.

e If Windows finds a file whose filename contains
a word with the search text you specify, it
displays that file in the File Explorer window.

Lesson 3
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Understanding File Types
.

e A computer can contain three categories of files:
system files, application files, and data files.

e System files are those necessary for running the
operating system.

e An application file is part of an application, such as
a word-processing application, and it is a necessary
file for running the software.

A data file is one you create when working with an
application.

e Many system and application files are executable
files that perform tasks automatically when you open
them.

Morrison / Wells / Ruffolo CLB: A Comp Guide to IC3 5E
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Understanding File Types
(continued)

TABLE 3-3 COMMON FILE OPERATING SYSTEM OR
CATEGORY EXTENSION APPLICATION
System files .dll, .ocx, .sys Windows
Application files .bat, .com, .exe Windows
.app, .0sx Mac 0OS X
.bin Linux, Mac OS X, Windows
.out, .run Linux
Data files
Media .avi, .mov, .mp4 Video application
m .jpg, .png, .tif Graphics application
(- .mp3, .m4a, .wav Sound application
@) Office .doc, .docx Microsoft Word
8 documents .mdb, .accdb Microsoft Access
GJ .ppt, .pptx Microsoft PowerPoint
- Xls, .xlsx Microsoft Excel
Simple text rtf, ixt Text editor
Other .htm, .html Web browser
.pdf Portable document reader
or editor
.Zip File compression utility

© 2015 Cengage Leaming
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Summary

In this lesson, you learned:

e The characteristics and capabilities of a computer’'s
Internal hardware components directly influence
computer performance.

e You store files in folders, which are containers for related
files, and on drives, which are storage devices. You use
folders to organize your files on a drive.

e A computer can store folders and files on different types
of disks, including removable media and hard disks.
Before your computer can access a removable disk, you
must insert the disk into a drive, which Windows names
by assigning it a drive letter.

Morrison / Wells / Ruffolo CLB: A Comp Guide to IC3 5E
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Summary (continued)
.

e \Windows organizes the folders and files in a
computer in a hierarchy called a file system. At
the top of the file system is the root directory,
}NT(;Ch IS where Windows stores system files and

olders.

The file management tool in Windows 8 is called
File Explorer. You use File Explorer to display
files and folders, navigate the Windows file
sys&em, and perform other file management
tasks.
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Summary (continued)
.

e To navigate a computer with File Explorer, you
click expand icons in the Navigation pane until
you find the folder that you want. Then, you click
the folder icon in the Navigation pane to view the
folders and files it contains, which are displayed
In the right pane.

e A file path is a notation that indicates where a
file I1s stored. A file path includes the drive name
and letter, folder and subfolders, and the full
filename.

Lesson 3
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Summary (continued)
.

e A full flename includes the main part of the
filename, a dot, and the file extension, which Is
usually three or four characters that identify the
file type.

Using File Explorer, you can view the contents of
a folder in eight ways, including Detalls view,
which lists details about each file, and Large
icons view, which displays a preview of the file’s
content if the file includes graphics.

Lesson 3
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Summary (continued)
.

e To organize files, you group similar files together in
a folder, preferably a subfolder in one of the
Windows default folders. Separate the files into
subfolders depending on the purpose or subject
matter of the files, and organize the subfolders from
the top down.

After creating folders and subfolders according to
your file organization, you can copy and move files
Into the folders using several methods. Some
methods use the Clipboard, which is a temporary
storage area for files and information that you copy
olr move from one place and plan to use somewhere
else.
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Summary (continued)
.

e You should delete files and folders you no longer
need to stay organized. When you delete a file
from a hard disk, Windows removes the file from
the folder but stores the file contents in the
Recycle Bin until you remove them permanently.

The names of folders and files should reflect
their contents, and can contain up to 255
characters, except for certain characters that
have special meanings in Windows.
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Summary (continued)

e In Windows, a shortcut is a quick way to perform
an action such as opening a folder or a file. You
can create shortcuts on the Start screen and on

the desktop.
e To find a file using File Explorer, you click the

Search box and then start typing text associated
with the file, such as a word in the filename.
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Summary (continued)
.

e The three categories of files on a computer are
system files, application files, and data files. A
system file is one necessary for running the

operating system. An application file is a

necessary file for running the application. A data

file Is one you create when working with an
application.

You should be able to recognize common files
types and their file extensions so you know
which files to avoid (system and application
files), and to identify applications you can use to
open files.
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